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1. OVERVIEW 

1.1 Interface description 

 

1.1.1 Project Sections menu 

On the left-hand side of the interface, you can access the different sections used to create a 
Project. Depending on the tab selected, the ribbons accessible are changed. 

1.1.2 Main Ribbon 

On the upper part of the screen, you can find the ribbon. The ribbon contains different tabs, 
each with different functions. This is where you will find the tools to perform your desired 
actions. 

1.1.3 Quick access toolbar 

On top of the ribbon is the quick access toolbar. This toolbar contains several handy functions 
to facilitate the use of TubePro. The Quick Access Toolbar can be customized. 

 

A. Undo/Redo: The left arrow allows you to undo the last action you performed, and the 
right arrow cancels the last undo. 

B. Refresh: Refreshes the main report. 

C. Project Browser shortcuts: The left symbol opens the properties tab in the Project 
Browser and the right symbol displays the Project Browser on the right side of the 
screen. 

D. Macros: Opens the Macro Manager window which allows the user to modify/add 
macros and counters. 
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E. Zoom options: The first two symbols allow the user to zoom in and out in a view, 
which can also be done using the mouse wheel. The last symbol makes the view fit to 
the main window. 

1.1.4 Project Browser 

On the right-hand side of the interface, you can find the Project Browser. The Project Browser 
gives information on the current view and contains customizable fields. The tabs in the Project 
Browser change depending on the current subsection. 

1.2 General functions 

These are some basic functions that need to be explained in order to use TubePro efficiently. First off, 
here are the differences between a Template and a Project file: 

1. TupePro Project File: A file that contains all the elements of a report including the tube sheet 
map, the properties and the data. The extension is T5PRJ. 

2. TubePro Project Template: A file that contains all the elements of a report but without the tube 
sheet map layout, nor the data sets. The drawings, graphs, tables and spreadsheets are included 
and just need to be refreshed with the newly created tube sheet. The properties are also kept. 
The extension is T5TPL. 

The following table lists the components that each file contains: 

 Project Template 
(T5PRL) 

Project File 
(T5PRJ) 

Tube sheet No Yes 
Picture used to create the Tube sheet No Yes 
3D Model No Yes 
Inspection Data No Yes 
Properties Yes Yes 
Drawings Yes** Yes 
All the Project items: 
- 3D Model views 
- Spreadsheets 
- Legends 
- Charts 
- Plugged Tube Ratio (PTR) diagram 

Yes** Yes 

Macros Yes Yes 
Report Yes** Yes 

**These features need to be updated with the appropriate inspection data once you create a new 
Project File with a Project Template. 

In summary, the Project Template contains the general structure of your report. Having a template 
separate from your Project File allows you to build multiple reports with the same layout. The Project File 
is the file that contains your data and is created for each of your inspections. 
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1.2.1 Creating a project 

There are two ways to create a project. You can either create a projet without any template structure or 
you can create a project with a template that you’ve previously designed. 

Click on the New button under the PROJECT tab and select the desired option.  

 

If you are using TubePro for the first time, it is recommended to create a project with a default template. 
It already includes relevant fields and it can be modified to match your requirements.  

1.2.2 Measurement units 

The measurement units can be changed from different location. First access MAP-Basic, 3D MODEL, 
INSPECTION DATA, DRAWINGS or REPORTS. In each of these sections, in the main Ribbon, select the 
PROJECT tab and select the desired unit from the drop-down list. 

*** It’s important to change the units in each section AND change it before creating 
tubes or importing data. 

 

The system will show the length measurement in inches or in millimeters accordingly.  

This option does not modify the values imported in your report. If you switch from a unit to another, the 
indications locations won’t be modified to match the unit modification. 

1.2.3 Decimal mark 

To choose the appropriate decimal mark that is coherent with your computer settings, you have to set 
it. Go to REPORT side menu, in the ribbon, select the REPORT tab. There is a dropdown list where you 
can choose the format that you want to use. 
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1.2.4 Button description 

To get a short description of a button you can place the cursor over it.  

 

1.2.5 Moving in a view 

- Translation: hold right mouse button. 
- Zoom in and out: Use mouse wheel. 
- Move a 3D model: Hold mouse wheel button and move mouse. 

2. CREATING A TUBE MAP 

The following functions can be found in the MAP - ADVANCED tabs. They are used to build a tube sheet 
of an exchanger and to define the tube numbering order.  

 

There are 2 different workflows to creating a tube sheet. The first one is to automatically detect the 
tubes on a picture or a PDF. This a very fast and useful method. 

The second is to manual insert the blocks in rectangular and/or circular. To learn out to do it, jump 
down to 2.3.  

2.1 Automatic photo detection 

A photo of an exchanger can be imported in the main window of the Map tab and TubePro can 
automatically detect the tubes on it. 
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To facilitate the detection, we suggest being as parallel as possible to the tube sheet and use the 
maximum picture quality possible.  

To load the photo, first navigate to the PHOTO tab and click on LOAD icon. 

In the dropdown menu, user must choose between Photos or Drawings.  

 

This distinction between the two types of files is important because it changes the algorithms of detection. 
A photo is a picture, such as a .jpeg, while a drawing is a file in the .pdf format. Section 2.1.1 will present 
the workflow for a PDF and will be for a picture. 

2.1.1 Using a drawing for detection 

When importing a drawing, the following window appears. 

 

Enter the page number where the drawing is in the PDF file. Once this is done, another window 
appears: 
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In this menu, you can set the outside diameter (OD) of your tubes and you can rotate and flip 
the drawing before it’s displayed in the tube map. Once the necessary adjustments have been 
made, click OK. All the tubes are detected with a 100% accuracy.  

2.2 Tube auto-detection based on a photo 

When detecting the tubes on a picture, a few simple steps are required to optimize the detection. 

2.2.1 Rotating the photo 

The picture can be rotated if the rows of tubes in your photo are not parallel to the axis in the 
software.  

To do so, in the PHOTO tab, click on the Rotate Left and Rotate Right buttons.  

 

For example, here’s a photo where the tube rows are not horizontal. 

 

Below, he photo has been rotated by clicking Rotate Right.  
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2.2.2 Tilting the photo 

If your camera was not centered and/or parallel to the tube sheet when the photo was taken, 
some tubes may seem smaller than they are. This will also lead to uneven apparent distance 
between the tubes.  

To correct this effect, it is possible to tilt the sides of the photo. In the PHOTO tab, click on the 
appropriate Tilt button. The tilting effect can be cancelled by using the Reset button. 

 

 

Finally, the picture is ready for detection. All remains to be done is to Click on the Detect icon. 

 

Select the area where you want to software to detect tubes. For larger tube sheets, it is advanced 
to do multiple detection zones. It helps to detect more tubes and the detected tubes will not be 
duplicated. 

The detection sensitivity can be adjusted with the scrolling bar at the top of the main view. If 
some tubes are missing, you can use manual tools to add the remaining tubes. 

2.2.3 Specifying the scale on a photo 

Now that the tube sheet as been created, the relative measurement between the computer 
screen and the picture needs to be set. This way, the system will be able to draw the tubes with 
dimensions that will match the imported photo.  

To start, a tube needs to be selected. After, in the SELECTION tab, click on Tube Scale: 

 

Specify the tube outer diameter that is shown on the picture using the Tube Diameter field. 
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In order to make sure that all the tubes in your bundle have the same OD, select them all and 
click on the Tube O.D. button in the COMMON tab. 

 

Specify the size of your tubes. 

 

2.2.4 Set the OD for all the tubes 

Now that the scale has been set, the OD of all the tubes will have to be defined. To do so, go in 
the COMMON ribbon, click on the tool Select All Tubes.  
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Then, just next to it, use the Set Tube OD tool.  

Tube OD can also be set when all the tubes are selected by changing the value of the Properties 
in the right side menu. 

2.3 Inserting a rectangular block of tubes 

In the Project tab, select Insert Block and choose Rectangular block of tube. 

 

A window appears to define the parameters of the block:  
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There are 2 possible options to define the geometry of your block: Specify by Pitch and Pattern or Specify 
by Center Distance 

The Pitch is the height between the center of tubes of two adjacent rows.  

 



 

TubePro 5.4 
Version 2 

19-11-14 

 

14 | P a g e  
  

2.4 Inserting a single tube 

Select the MAP – ADVANCED subsection. 

 

In the COMMON ribbon, select Single. 

 

Click on the location where you want to add a tube.  

2.5 Selecting tubes 

In the Edit tab, select the area button. 

 

Surround the section you want to select.  

The same operations can be done with the other options in the Select group of function.  

2.6 Moving tubes 

Select the section you want to move with the previous functions.  

Click on the Move button in the COMMON tab 

 

Select the reference point and then select your destination point. The selected section will move by the 
distance difference between the 2 specified points.  

You can also change the orientation of your bundle by using the Rotate function in the COMMON tab. 
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Select the tubes that you want to rotate and hit the Rotate button in the COMMON tab. Click on the 
center of the rotation and then click at another point in your map to create a reference axis. To finish 
the rotation, click on another point where you want your reference axel to move to complete the 
rotation. 

 

2.7 Deleting tubes 

Click on the Remove Area button in the COMMON tab 

 

Surround the section you want to delete.  

Other options are available in the Remove group of functions.  
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2.8  Aligning a selection of tubes 

Select the tubes you want to align.  

Click on the button that correspond to the alignment you want in the Align subsection of the SELECTION 
tab. 

 

The most commonly used buttons are Align vertically  and Align horizontally . These buttons 
align the center of the tubes, either horizontally or vertically, if they are close enough from each other. 
They are used to align multiple rows and columns of tubes at the same time. 

Here is an example of tubes before and after they’ve been aligned, both horizontally and vertically. The 
positions of the tubes’ center before the alignment are slightly offset from each other whilst after the 
alignment they are arranged in grid pattern. 

  

The join buttons relocate all the tubes selected on the same horizontal  or vertical  line. This 
tool is used for just a single line, not the whole tube sheet. 

 

Here’s an example of tubes that have been joined vertically. 
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2.9  Adjusting the numbering 

TubePro has different tools to help you create the exact numbering you are looking for.  

To view, the current numbering, select the Row and Column options in the VIEW tab 

 

The Tube # tool can also be used to show each tube’s row and column. The numbering settings can be 
found in the Arrange & Order function group under the COMMON tab.  

 

Tubes can be identified by row and column with the following format: X:Y, where X is the row and Y is 
the column number. The reference number 1:1 can be set in different ways.  

The option Rows are horizontal  set the 1:1 tube as the first tube of the first row of the bundle.  In 
this case X is the row number.  
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The option Rows are vertical  set the 1:1 tube as the first tube of the first column of the bundle.   In 
this case X is the column number.  

 

Tubes can also be identified with a single number by selecting a third numbering option :  
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The numbering order can be reversed horizontally or vertically by selecting the following options:  

 

These tools can be used if to switch the numbering from left-to-right to right-to-left, or from top-to-
bottom to bottom-to-top. 

Another numbering method that is available to you in TubePro 5.4 is the Grid method which numbers 
the tubes on a grid. To do so, click on the Use Grid Numbering under the COMMON tab. 
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2.10 Creating and assigning a section 

A section identifier can be added to parts of a bundle. It can be used to defined the numbering.  

To define a section: 

- Select the tubes you want to add to a section 
- Click on the Add Selected Tubes to Section button in the TUBES tab. 
- Select the section in the list.  
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If you want to create a new section, click on Add and enter the name of the new section. 

 

Click on OK to apply the changes. 

2.11  Exporting a tube list 

Once your mapping is done, you can export your tube list to use it in your acquisition software. 

Click on the Export button in the TUBES tab 

 

Select the LST format to use the list with Magnifi: 

 

 

And save the file in the chosen destination. 
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3. 3D MODEL 
The following settings and functions can be found in the 3D MODEL tab located on the left side of the 
main window. They are used to build a 3D representation of an exchanger. 

 

3.1 Display functions 

A set of function in the upper center of the main window of the 3D MODEL tab allows you to change the 
angle at which you want to visualize your bundle model. 
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It is also possible to select a visualization angle by using the cube at the upper right of the main window. 
Clicking on a section of this cube will rotate and adjust your bundle to the corresponding angle.  

Zooming in or out can be done by using the wheel on your mouse. The 3D view can be paned by holding 
right button of the mouse while moving the mouse. Rotating the bundle can be done the same way but 
with the left button of the mouse.  

3.2 Tube properties 

The length and type of tubes can be adjusted in the Bundle Geometry settings at the right side of the 
interface in the Project Browser: 

 

Tube length must correspond to your inspection data. If flaws are tagged outside this length range, they 
will be shown outside of the bundle in the 3D model.  
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3.3 Tube sheet Geometry 

Tube sheet geometry settings can be found at the right side of the interface in the Project Browser;  

 

It is also accessible under the MODEL tab: 

 

To add a tube sheet, click on Add 
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A table showing a list of tube sheet parameters will appear. Properties can be modified by changing the 
values in this table.  

Click on Apply to apply the modification to your model.  

3.4 Support plates 

Support plates can be added to your bundle by clicking on the Support Editor button under the MODEL 
tab.  

To add a set of support plate, click on Add 

 

A table showing a list of support plates parameters will appear. Properties such as the type of support 
plate, the number of support and the distance between them can be modified by changing the values 
in this table.  

Click on Apply to apply the modifications to your model.  

3.5 Nozzles 

Nozzles can be added to your bundle by clicking on the Nozzle Editor button under the MODEL tab.  

To add a nozzle, click on Add 
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A table showing a list of nozzle parameters will appear. Properties can be modified by changing the 
values in this table.  

Click on Apply to apply the modifications to your model.  

3.6 U-Bends 

To build 3D model of a heat exchanger with u-bends: 

In the Properties tab of the Project Browser select the bundle Unit Type to U-Bends Sections. 

 

If the parts of the bundle that needs to be connected by a U-Bend mirror each other, then the U-Bend 
will automatically be created after the selection of this Unit Type. 
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4. INSPECTION DATA 
TubePro will create a tube list based on the tube mapping build in the MAP tabs. This list can be found in 
the INSPECTION DATA tab.  

 

4.1 Importing data from an acquisition software 

Once the acquisition of you bundle is completed, you can import the report created with your acquisition 
software.  

In the PROJECT tab, click on Import Data 

 

You can either replace the set of data or append the imported data: 

 

The software will display the flaws in your 3D representation based on the Location and Extent field.  

A legend can also be built in order to show the degree of deterioration of the tube based on fields relative 
to this information (percentage, Actual Wall Loss, …). This option can be found under the DRAWING tab. 

5. DRAWINGS 
Drawings are customizable pages that can include relevant information such as 2D and 3D representation 
of your bundle, graph and color legends.  They can be inserted as a full page in your report.  

The following settings and functions can be found in the DRAWING tab. 
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5.1 Adding a drawing page 

Click on the New button under the DRAWING tab: 

 

Select the desired template and click OK. 

5.2 Changing a drawing page layout 

Click on the Page Setup button under the DRAWING tab 

 

Change the parameters to the desired values. 
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5.3 Inserting an element in a drawing 

Select the Project tab in the Project Browser window at the right side of the interface: 
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Different groups of elements can be found under this tab. These different items can be easily dragged 
and dropped from the list to your drawing.  To edit the parameters of an element, simply double-clicking 
on it. You can move an element in a drawing page by dragging it with the left button of the mouse.  

If an element is not up to date with the latest defects, simply press the Refresh button in the Quick Access 
toolbar. 

5.4 Create an element 

Elements can be created to show, for instance, your 3D model for a given orientation.  

Select the Project tab in the Project Browser window at the ride side of the interface. 

Click on the New Report Element button in the upper list of functions of this tab.  

 

Select the type of element you want to add 



 

TubePro 5.4 
Version 2 

19-11-14 

 

31 | P a g e  
  

 

If applicable, enter the requested parameters.  

The newly added element will be available in the element list. Parameters can also be modified by double 
clicking on it in the Project browser.  

6. REPORT 
Starting with version 5.4, it is now possible for the user to create a report based 
on a text template or a spreadsheet template. The tables and pagination tools 
of Word can be used to enhance your report and all the representations, 
images, drawings and defect tables will be displayed. On the other hand, 
spreadsheets allow for calculation-based tools. Regardless of the format, all the 
Field Codes entered in your report will be linked and automatically updated. 

To access the report, simply select its section on the left side menu. 
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6.1 Page Layout 

To modify the layout of your report:  

Go to the PAGE LAYOUT tab  

 

 

Parameters such as the page orientation, margin dimensions or the number column can be adjusted 
there. 

6.2 Inserting a field 

Variable that are linked to a single editable field can be inserted in the report. This allows the user to 
modify information, such as the client name for instance, at only one place even if this information is 
found at multiple places in the report. 

Two techniques can be used to insert a field in you report: 

6.2.1 Drag and drop method: 

- Go to the Project Browser at the right of the screen 
- Click on the variable you want to insert in the report and hold button. 
- Drag and drop it to the chosen location.  

6.2.2 Double-click method: 

- In the Word document, place the cursor where you want to add the Field Code. 
- On the right-side menu, double-click on the property you want to add. 

6.3 Creating a field 

Go to the Properties tab of the Project Browser 

Click on the first icon in the top left 
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Select the type of field you want to create and configure its parameters. The new property will be 
available on the Properties tab of the Project Browser. 

6.4 Inserting an element 

Go to the Project tab of the Project Browser 

Drag and drop the desired item to the desired location. 

6.5 Exporting a report 

When satisfied with the result, it is then possible to generate the report from the interface. Simply click 
on the Build PDF Report icon and the following window will be displayed: 
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Page by page, you will be able to choose the content of your report. The order in which it is presented in 
the list is the order in which the pages will be assembled. 

With this menu, it is then possible to arrange a PDF that contains DOC pages, XLS pages as well as all 
the other item types. 

Once the pages have been selected, you can then click on Save and the Windows explorer will be 
displayed so you can choose the desired location for the file. 

6.5.1 3D model in the report 

Starting with 5.4, it is now possible to insert the actual 3D model in your PDF report. When the 
report is then sent to a client, the later can then change the appearance of the model to his 
likings. For an example of the end result, you can follow this link to a demonstrative video: 
https://youtu.be/kUr4ffDv8AM.  

To insert a 3D model, you need to select the Drawings with a name that starts with 3D.  
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